
Welcome to eChalk 
Carmel School District – 
Welcome to the eChalk Community 
 
Introduction 
 
eChalk is an online learning environment that connects students, teachers, parents and 
administrators within your school and district. eChalk provides your school district with 
web based email, District and school Websites, class Web pages, department or group 
Web pages, and online tools for teachers, administrators, students and parents that 
facilitate 2-way anytime, anywhere communication. 
 
Because safety and security are important in a school environment, eChalk has both 
public and private features. Your school and district can choose what information is 
available to the general public by publishing items on the public side of eChalk. 
Alternatively, you can also choose to allow only targeted groups of your school 
community to receive information by publishing it privately. The school community 
members then access this information by logging in to a private account. 
 
You can use eChalk to: 

 Communicate digitally using a web –based email system. 
 Keep parents and students up-to-date and accountable with important class 

information. 
 Interact with students using safe and secure email, online class discussions, and 

surveys. 
 Save time by using online publishing tools to post class activities, projects, and 

resources. 
 Keep informed about upcoming district, school and classroom events. 
 Store information for easy access from any computer connected to the Internet. 

 
Remember that your eChalk site is available from any computer with an Internet 
connection so you can access eChalk from a computer lab, your classroom, the library, 
and home. 
 
Have fun getting to know your site and discovering all the new ways you now have 
to communicate, collaborate and connect with the members of your school community! 
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 NOTE: If you do not have your ID & PW to login, please contact your 
building site manager for the information. 
 
Logging In
   

 
 
     To log in: 

1 Locate the eChalk login link on your District or school homepage. 
2 Click in the space to the right of Username, and type your username (e.g. 

mary.brown). 
3 Click in the space to the right of Password, and type your password.   
         
                 Note: Dots will appear to disguise what you type. 
 
 
4 Click the Login button. 
 

Note: Your username is derived from your first and last name, 
usually in one of the following forms: 

Power Tip: Click the Forgot Password? link on 
the login box. This will allow you to send a 
message to your Site Manager who can reset 
your password. 

• Your first name and your last 
name separated by a period 
(mary.brown) 

• Your first initial and last name 
(mbrown) 

• If there are multiple users with the 
same name, there may be a 
number in your username 
(mary1.brown). 

Contact your Site Manager if you need your username and/or password. 

Questions?  Contact support@echalk.com or 1-800-499-2741           
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First Time Log In 

The first time you log in to eChalk you will go through a one-time procedure to activate 
your account. 

 
     To complete the first-time log in process: 

 
1 Click the Accept button located at the bottom of the Acceptable Use Policy (AUP).  

This policy was written by your school or district and outlines the guidelines of 
acceptable use for your eChalk site. 

 

 
 

2 The next screen requires you 
to change your account 
password.  Type a new 
password in the New 
Password box and then re-
type it in the Confirm New 
Password box below. 

 

 
Note: Try to choose a password that is easy for you to remember but 
hard for others to guess.   

 
3 Click the Submit button.   

*Remember: The next time you log in to eChalk you will need to use the new password you 
selected.   

Questions?  Contact support@echalk.com or 1-800-499-2741     
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Setting Your User Profile 
The next screen will help you set your User Profile.  Your User Profile tells the system 
specific information about who you are at your school and categorizes you in the Faculty & 
Staff Directory accordingly. 

This information will also display on your personal profile page, which can be viewed from 
your school homepage if you choose to make the page public. 

  

 
 

It is only necessary to complete the required fields (identified by red asterisks) during the 
first-time log in process.  You will be able to access this information again to make additions 
and changes once you have activated your account. 

 

In Step 1 on the Profile page, select a position from the Position in School/District drop 
down menu.  Teachers will also be required to select the grades they teach in the Grades I 
currently teach field.   

 
Note:  Teachers also need to fill out the Subjects & Courses field in 
Step 2 of 3.  This area requires you to choose the subject(s) and 
course(s) that you teach and will categorize you in the site directory 
appropriately.  Within the My Classes section of your user account, 
you will be able to specify the exact name of your class. 

 

     To select the courses you teach (Teachers only): 
1 Select your subject area from the Select a Subject drop down menu. 
2 Highlight a course name from the Select a Course field. 
3 Click the Add button to move the course into the Subject & Courses field. You can 

select and add as many subject and/or course names as apply. 

Questions?  Contact support@echalk.com or 1-800-499-2741           
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Subject, course and position listings are maintained by the Site Manager and Site 
Administrators at your school or district.  Please contact your Site Manager to suggest a new 

hed completing your User Profile, click the Finish button at the 
bottom of the page. 

 

ersonal User Accounts 
e login procedure, you will have your own private password-

rotected eChalk account.     

ersonal user accounts include access to the following features: 

 tools 
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My Email  
Allows users to send and receive email messages, and also includes more sophisticated
such as an address book to store other contacts.  
a

 Account 
Files – Provides you with the ability to save files, like Microsoft Wo
documents, to your account.  This allows you to access
time from any computer with an Internet connection. 

Bookm
links. 

Profile– Enables you to edit and up
and also to change your password. 

 

 

Questions?  Contact support@echalk.com or 1-800-499-2741     
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My Classes 
Allows teachers to post assignments, collect student work and share class materials.  Allows 
students to view assignments, submit homework, collect class materials and participate in 
online discussions. 

My Groups 
Through eChalk Groups, administrators, staff, teachers, students and parents can post, 
share, and discuss special events, important files, and interesting Web links, quickly and 
easily by department, grade-level, or other organization.  

 

My eChalk Community 
My School Tools 
 
From your user account, you will also have access to other school tools, including: 

 

 

 Homepage – Displays the content available on your 
school’s homepage.  From inside the site, all 
information designated as private will now be 
viewable. 

 Calendar – Displays a full month view of your 
school’s calendar including all information 
designated as private. 

 Discussions – Designated users can participate in 
online discussions with faculty and staff, students 
and other members of the school community. 

 Find Members – A searchable directory that lists 
the email addresses of the members of your 
district’s or school’s eChalk system. 

 
Now that you have been introduced to eChalk, have fun 
exploring and discovering all the new ways you now have 
to communicate with other members of your school 
community. 

 
 

Questions?  Contact support@echalk.com or 1-800-499-2741           



 

Updated: 08/22/07, AS 

Focus On… 
My Account 
 

Introduction 
The My Account area in your eChalk account allows you to store personal 
files, access a shared file storage space for your school and district, store 
bookmarks for Web sites and build and maintain a personal Profile page. 

 

Files 
The Files area allows you to store files, such as Microsoft Word documents, 
PowerPoint presentations, and photos in your eChalk account for easy access 
from any computer connected to the Internet.   Students may even store 
homework in their My Files area and submit it to their teacher electronically 
using the Homework Drop Box feature in My Classes.   
 
 
 
 
 
 
 
 
 
 
 
 

In This Guide 
 
• Use private file 

storage 
• Access shared file 

storage 
• Store bookmarks 
• Edit your profile page 
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14 Troubleshooting/ 

FAQ 
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Files 
Personal 
Every user with an eChalk account has access to personal file storage in the My Files area (Fig. 
5.1). This is a private storage area--no one else can open or view files stored in the My Files area. 
Think of it as a locked filing cabinet for which only the user has the key. 

 
Figure 5.1 
 

       To store a file in My Files:  
1 Log in and click the My Account button on the side toolbar. 
2 Click the Add button. The Add Files page appears. 
3 Click the Browse button to select the file to add. A directory window opens. 
4 Navigate the directory until you locate and select the file to be stored. 
5 Click the Open button to select the file to upload. The Add Files page reappears. 
6 Click the Upload button. 
7 The My Files page will reappear when the process is complete. 

 
Note: Before you start, be sure you know where the file you will 
upload is saved on your local computer (maybe on your Desktop, or 
in your My Documents folder).   

 
       To email or access (download) a file from My Files: 

1 Log in and click the My Account button on the side toolbar, the My Files page will 
display. 

2 To email a file, click the checkbox to the left of the filename and click the Send Mail 
button.  This will bring you to the Write Mail page where the file will be attached to an 

Power Tip: You no longer need to carry around disks 
or flash drives.  Instead save your working documents 
in your eChalk account and you can download them on 
any computer with Internet access. 
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email which you can send to another user.  Refer to the My Email Feature Guide for 
further instruction on sending email. 

3 To download and work with a file, click on the file name link or the Open file in a new 
window icon      .  When the file name link is clicked the File Download window 
opens, displaying three Download Options: 

• Download option #1 provides the option to open the file in a new Web browser. 
• Download option #2 provides the option to open the file in its registered 

application. 
• Download option #3 provides the option to save the file to your computer.  To 

do this, right click on the Save icon or hyperlink and choose Save Target As… 
 
 
Files 
School 
School teachers and administrators can share files with other teachers and administrators 
through the School Files area (Fig. 5.2).  The School Files area is only accessible to teachers, 
administrators and staff members with eChalk accounts at the same school site; students and 
parents do not have access to this area.  
  
 

 
       Figure 5.2 
 

       To email or access (download) a file from the School Files directory: 
1 Log in and click the My Account button on the side toolbar, the My Files page will 

display. 
2 Click the View Another Folder drop down menu, and click on School Files.  The 

School Files page will display. 
3 Click a folder name link to open the folder. The titles of the files stored in that folder will 

display.  
4 To email a file, click the checkbox to the left of the filename and click the Send Mail 

button.  This will bring you to the Write Mail page where the file will be attached to an 
email which you can send to another user.  Refer to My Email Feature Guide for 
further documentation on sending email. 

Power Tip: Creating a folder or adding a file to the 
School Files area requires Site Administrator 
privileges.  
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5 To download and work with a file, click on the file name link.  When the file name link is 

clicked the File Download window opens, displaying four Download Options: 
• Download option #1 provides the option to open the file in a new Web browser. 
• Download option #2 provides the option to open the file in its registered 

application. 
• Download option #3 provides the option to save the file to your computer.  To 

do this, right click on the Save icon or hyperlink and choose Save Target As… 
• Download option #4 provides to option to save the file to your My Files folder in 

eChalk. 
 
 

Files 
District 
District-level employees can share files with all teachers and administrators throughout the 
district through the District Files area (Fig. 5.3).  The District Files area is only accessible to the 
district’s teachers and administrators with eChalk accounts; students and parents do not have 
access to this area.  If your school is not part of an eChalk district, the District Files area will not 
display.  

 
        Figure 5.3 
 

       To email or access (download) a file from the District Files directory: 
1 Log in and click the My Account button on the side toolbar, the My Files page will 

display. 
2 Click the View Another Folder drop down menu, and select District Files.  The 

District Files page will display. 
3 Click a folder link to open the folder. The titles of the files stored in that folder will 

display. 
4 To email a file, click the checkbox to the left of the filename and click the Send Mail 

button.  This will bring you to the Write Mail page where the file will be attached to an 
email which you can send to another user.  Refer to My Email Feature Guide for 
further instruction on sending email. 
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5 To download and work with a file, click on the file name link.  When the file name link is 
clicked the File Download window opens, displaying four Download Options: 

• Download option #1 provides the option to open the file in a new Web browser. 
• Download option #2 provides the option to open the file in its registered 

application. 
• Download option #3 provides the option to save the file to your computer.  To 

do this, right click on the Save icon or hyperlink and choose Save Target As… 
• Download option #4 provides to option to save the file to your My Files folder in 

eChalk. 

 
Bookmarks 
A bookmark is a shortcut to a particular Web site or Web page.  When you find an interesting or 
helpful Web site/page, you can record its address (the URL) within the Bookmarks area (Fig. 5.4) 
of My Account.   

Sometimes bookmarks are stored directly on a computer’s Internet browser (called Favorites in 
Internet Explorer).  This means that the shortcut to the Web site/page is only available on that 
specific computer.  However, eChalk Bookmarks can be retrieved from any computer with 
Internet access. 

 
       Figure 5.4 
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       To add a Web site/page to your bookmarks: 

1 Log in and click the My Account button on the side toolbar. The My Files page 
displays. 

2 Click the Bookmarks button on the side toolbar. The Bookmarks screen displays. 
3 Click the Add button. 
4 Type (or copy and paste from another Internet browser window) the Web page 

address that you would like to add in the Web Site Address box (e.g., 
www.kidsclick.org) 

5 Type a more familiar or descriptive name for the web page/site in the Name box (e.g., 
CNN News, or NASA Web site) 

6 Optional: Categorizing your bookmarks is a helpful way to keep organized.  You’ll save 
time searching through long lists of bookmarks to find the one you want. 

 To create a new category, type a name such as Personal Links, History 
Bookmarks, or Travel in the New Category box. 

 You may also select a previously created category from the Existing Category 
drop down menu. 

 
7 Optional: Select the Add to My Profile page check box under Sharing to post this link 

on your personal Profile page as well. 
8 Click the Save button. 

 
The Bookmark Tool allows you to add a favorite Web site to your Bookmarks list without 
being logged in to your eChalk account.  If you use the Bookmark Tool, you will be able to just 
click an eChalk button in your browser and the Web site you are currently viewing will be 
added to your Bookmarks list.  See the following instructions for adding the tool. 

 
 Note: The eChalk Bookmark link will only display if you have Show 
Screen Tips checked in the Edit Options page of the Profile 
section of your account. 

 
 

       To add the eChalk Bookmark button to your browser: 
1 Log in and click the My Account button on the side toolbar. The My Files page 

displays. 
2 Click the Bookmarks button on the side toolbar. The Bookmarks page displays. 
3 Click and hold on the eChalk Bookmark link from the Screen Tips at the bottom of 

the Bookmarks page. 
4 While still holding the link, drag it up to the Links toolbar located in Internet Explorer. 

 
 Note: This tool is not compatible with Netscape Navigator on 
Macintosh computers at this time. 

 
 Note: If you cannot drag and drop the eChalk Bookmark link to 
your Links toolbar, follow this procedure:  

 Right-click on the eChalk Bookmark link. 

 Select Add To Favorites… 

 If prompted that adding the link to favorites may be unsafe, click Yes to 
continue. 
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 Select the Links folder. (If there is no Links folder, click New Folder, enter 
in Links as the folder name, and click OK. Then select the Links folder.) 

 Click OK. 
 

5 You should now see the eChalk Bookmark button on the Links toolbar in your 
browser. 

 
       To add a bookmark to your eChalk account using the eChalk Bookmark Tool: 

1 Locate a Web site/page that you want to save to your eChalk account. 
2 Click the eChalk Bookmarks button in your Links toolbar. (Personal ToolBar in 

Netscape Navigator for Windows). An eChalk pop-up window will display. 
3 Enter your eChalk email address and password in the spaces provided (if prompted). 
4 Click the Save Bookmark button (if prompted). When the process is completed, a 

confirmation message will appear. 
 
The next time you log into your eChalk account, the Web site/page link will appear in your 
Bookmarks. 
 
 
 



Focus On… My Account    

Questions?  Contact support@echalk.com or 1-800-499-2741           

8 
Profile 
The Profile page (Fig. 5.5) displays contact and other helpful information about a user publicly on 
the Internet (if desired) and privately to your school or district community. The original 
information for a Profile page is supplied by the Site Manager or by district-level 
administrators when an account is first created. 
  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.5 

Each user should review the current information on their Profile page and edit or add any 
missing pieces of information that they would like to include.  
 
 

Profile 
Editing a Profile: Teachers & Administrators 
Once the first-time log in process is complete (refer to the eChalk Introductory Guides for first-
time log in instructions), your profile page is created.  Details may change about your role in the 
district which require additional changes to your profile page, or you may wish to edit the 
information you initially provided.    
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       To make changes to your Profile: 
1 Log in and click the My Account button on the side toolbar. 
2 Click the Profile button on the side toolbar. Your current Profile displays. 
3 Click the Edit Profile button. 
4 In Step 1 of 3, choose Yes or No after Publicly Visible to the Internet if you’d like to 

make your profile public or private. 

 Public profiles can be viewed in 
the Faculty & Staff directory by 
anyone on the Internet. 

 Private profiles can only be viewed after logging into eChalk, and can be found 
in the Faculty & Staff directory on the My School page. 

 
5 Add or change your nickname.  If you are known by a name other than your given 

name, enter it here.  
6 Use the drop down menus to choose the position you hold in the school/district. 

 As an administrator or teacher, you should carefully examine the list of roles 
and choose one which most closely describes your position. This role will be a 
key to how other members search for you.  

 If your primary role is that of a teacher, leave the default as teacher. 
 

7 Teachers must place a check next to the grades they teach. 
8 Teachers must also identify the subjects and courses they teach. 
9 Include information such as: 

 Forgot Password – enter a question and answer in case you forget your 
password 

 Office phone number 
 Message 
 Biography – perhaps your degree, alma mater, year of graduation, or a special 

interest 

 Office hours 
 Room number 

 
10 Click the Save button at the bottom of the page when you’ve finished. 

 

Power Tip: Making your Profile public improves 
communication. 
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Profile 
Editing a Profile: Students & Parents        
Students and parents may add or edit a nickname on the Profile page. Student and parent 
profiles are never public to the Internet; they can only be accessed by school members with 
usernames and passwords. 

 
       To view and/or make changes to your profile: 

1 Log in and click the My Account button on the side toolbar. 
2 Click the Profile button on the side toolbar. The current Profile page appears. 
3 Click the Edit Profile button. 
4 Add or change a nickname. 
5 (Parents Only) Parents may add Contact Information to their Profile page. 
6 (Parents Only) Select a Forgot Password question and answer. 
7 Click the Save button at the bottom of the page. 

 
 
Profile 
Adding a Photo to Your Profile               
Teachers, administrators and staff can include a digital photo or an eChalk image on their 
Profile page. The photo should be sized to 70 X 100 pixels and saved as a .GIF or .JPG file to a 
folder on your local computer.  
 

 Note: For security reasons, students cannot add a photo to their 
profile page. 

 
       To upload an original photo: 

1 Log in and click the My Account button on the side toolbar.  
2 Click the Profile button on the side toolbar. The existing profile displays. 
3 Click the Add/Change Photo button. The Add/Change Photo page displays (Fig. 5.6). 
4 Click the Browse button and locate the file on your computer. 
5 Click the file name and click Open. 
6 Click the Upload button at the bottom of the page. 
7 The Profile page displays with the new image. 
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                                Figure 5.6 
 

Additionally, instead of displaying a personal picture on the Profile page, users can choose an 
image from the eChalk Image Gallery. 
 
 

       To upload an image from the eChalk Image Gallery: 
1 Log in and click the My Account button on the side toolbar.  
2 Click the Profile button on the side toolbar. The existing profile displays.  
3 Click the Add/Change Photo button. The Add/Change Photo page displays (Fig. 5.6). 
4 Select the Select an image from the eChalk Gallery link. 
5 Navigate through the image gallery categories to find an appropriate image. 
6 Select the Add Image link. 
7 The Profile page displays with the new image. 
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Profile 
Editing Profile Options                     
By selecting the Edit Options button, users can set personal preferences, including language 
preference for help tips (English or Spanish), the default start page and Rich Text Editing 
preference. 
 
 

       To edit profile options: 
1 Log in and click the My Account button on the side toolbar.  
2 Click the Profile button on the side toolbar. Your current profile displays. 
3 Click the Edit Options button. 
4 Change account settings: 

 Screen Tips Visibility: Screen tips are instructions that appear on select 
screens throughout your eChalk account. By default, the Screen Tips are 
enabled. Turn them off by un-checking the box.  Turning off the Screen Tips 
opens more space on the page. 

 Language Preference: By default, Screen Tips text and eChalk help text are 
in English. However, you can change the preference to display help in Spanish. 

 My Start Page: This setting determines the first page you see when you log in 
to your eChalk account. The start page can be adjusted to the area of eChalk 
that you use most frequently.  For example, a teacher may adjust the start 
page to My Classes. 

 Display Rows in your Email Folders & Address Book:  By default, ten rows 
of messages will display on one screen in all of eChalk’s email folders and ten 
rows of contacts will display on one screen in the eChalk address book. 
Change this setting if you prefer to view more/less than ten messages/rows. 

 Rich Text Editor: Displaying text on a screen the way it will look on a Web 
page is called Rich Text Editing, or “WYSIWYG.” This stands for “What You 
See Is What You Get” and is pronounced “Wizzy-Wig”. The rich text editing 
provides an interface similar to that in most word processors and allows you to 
change text color, make text bold, and change font size.  The Rich Text Editor 
can be used in most areas of your eChalk account where there is a text box for 
text entry descriptions, required information or email.  Check the box if you 
prefer the Rich Text Editor to be your default text editing option. 

 
5 Click the Save button. 
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Profile 
Edit Spell Check Options 
eChalk provides a Spell Check tool in many areas of the application.  The Spell Check tool can 
be used to check spelling for announcements, resources, calendar events, and emails, just to 
name a few examples.  By selecting the Edit Spell Check Options button, users can set 
personal preferences for how the Spell Check tool will check spelling. 
 
 

       To edit spell check options: 
1 Log in and click the My Account button on the side toolbar.  
2 Click the Profile button on the side toolbar. Your current profile displays. 
3 Click the Edit Spell Check Options button. 
4 The Spell Check > Edit Options page appears. 
5 Customize any spell check options in the Spell Check Options section. 
6 Choose the language you would like for the Spell Check tool in the Language 

section. 
7 Add any custom words in the Dictionary field, and click Add. 
8 If you would like to remove a custom word, click the word, and click the Remove 

button. 
9 If you would like to set up the Spell Check to autocorrect any words, enter the 

Original version (i.e. your common mistake) and the New (i.e. correct) version and 
click the Add button. 

10 Click Save. 
 
 
Profile 
Changing eChalk Passwords                            
It is good practice to change or reset your password frequently, i.e. every 3-4 months. This will 
increase the security of your account. 
 
 

       To change your password: 
1 Log in and click the My Account button on the side toolbar.  
2 Click the Profile button on the side toolbar. Your existing profile page displays. 
3 Click the Change Password button. 
4 Type your original password, a new password and then type the new password again 

to confirm. 
5 Click the Submit button to save changes. 

If you forget your password, you can click on the Contact Us link or the Forgot Password link 
on your homepage to contact your school Site Manager for assistance.  
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My Account    
Troubleshooting/FAQ 

Q: How do I set the Rich Tech Editor as the default option in eChalk? 

A: In order to set the Rich Text Editor as your default text formatting option, log in to 
your account and click on the My Account button.  Then, click the Profile button and 
select Edit Options.  On the Edit Options screen, check the box next to Use the Rich Text 
Editor by default to format text and click Save. 

Q: Why is my name not displaying in the Faculty & Staff Directory? 

A: If you have activated your account and your name is not displaying in the directory, 
you may have set your profile to display privately.  If your profile is set to private, your 
information will not be available on the public side of your site.  In order to change 
your profile setting so your information does appear on the public side of your site, log 
in and click on the My Account button.  Then, click the Profile button and select Edit 
Profile.  On the Edit Profile screen, select the Publicly Visible to the Internet radio button 
and click Save. 

Q: Can students view documents in the School Files or District Files area? 

A: No, students do not have access to the School Files or District Files area.  These areas 
are used to publish information for teachers, administrators and staff only. 
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Introduction 
 
eChalk is thrilled to introduce its new AJAX Email Client! Thank you for taking 
part in our Email Beta program to help us better our email system design and 
interface. 
 
You’ll notice a number of exciting improvements so that reading, composing 
and managing emails is faster and easier. You can view multiple email 
messages at once, automatically save and delete email drafts, auto-complete 
your email addresses and much more. At the same time, you’ll still enjoy 
eChalk’s reliability and user-friendliness. 
 
If you have any suggestions or problems with the new system, contact eChalk 
Support by clicking on Support Center or Contact Us in the upper right-hand 
corner of your eChalk site. 
 
This feature guide will walk you through the basics of the new AJAX Email 
Client. We’re looking forward to your feedback! 
 
 
 
 
 
 

In This Guide 
 
• Read and write emails 

using eChalk 
• Create and organize 

email folders 
• Use the Address Book 

and Find Members 
tools 

• Customize your 
personal email 
account settings 
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Using My Email Beta 
 
The first time you log into your eChalk account, you will see a welcome screen (Fig. 4.1) asking if 
you’d like to participate in the Beta program. To activate the new email client software, simply 
click on the Yes I want to try the new and improved email beta button. 
 

 
Fig. 4.1 
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After logging in to eChalk, click the My Email button on the left toolbar. Your email Inbox and 
the My Email navigation area will display (Fig. 4.2).  
 

 
Fig. 4.2 
 
The left navigation area contains two buttons at the top for quick and easy access to the 
functions you need the most. The navigation tree provides you with a clear view of all your 
folders, personal contacts, and email settings. You can click on the minus signs to hide content, 
and the plus signs to expand content. 
 
In the My Email left navigation area (Fig. 4.3), you will see the following 
buttons: 

 Folders – Click on the Folders button to create, rename, move, 
empty and delete folders. 

 Compose – Click on the Compose button to write and send email. 
 
Beneath those buttons, in the left navigation tree, you will see the 
following tabs: 

 Mailbox – Your Mailbox tab houses your five standard folders. 
 Inbox – Use your Inbox to read and manage mail you have 

received.                     
 Drafts – You can find drafts of email messages to be sent later 

in your Drafts folder. If you are composing a message, it will 
be auto-saved into this folder. 

 Sent Mail - Look in your Sent Mail to view copies of 
messages sent from your account. 

 Deleted Mail – Click here to view messages you’ve deleted. 
 Junk Mail – Look in your Junk Mail folder for mail that was automatically filtered 

out of your incoming messages. 
 My Folders – You can find your custom email folders under the My Folders tab. 

Power Tip: Use the horizontal and vertical 
scroll bars to read tab names in the left 
navigation tree. 

Fig. 4.3 



     Focus On… eChalk Email Beta 

Questions?  Contact support@echalk.com or 1-800-499-2741           

4 
 Contacts – Clicking on your Contacts tab will open up your Address Book, which is 

where you can store email addresses or group distribution lists. 
 Options - Click on the Options tab to configure your personal email settings, including 

General Options, Security Settings, Storage Space settings, Message Signature, 
Forward/Reply settings, Wireless Settings for Emergency Alerts, and Advanced 
Options. 

 
 
When you open any of the tabs under My Email > Mailbox in the left navigation tree, you’ll see 
the grey action toolbar (Fig. 4.4) at the top of your screen.  
 

 
Fig. 4.4 

 
In the grey action toolbar, you will see the following options: 

 Delete button – Click on the Delete button to delete the selected message. You will be 
asked to confirm the deletion. Click Yes to confirm or No to cancel.  

 Reply menu – Roll over the Reply menu to Reply to Sender or Reply All. 
 Forward button – Click on this button to forward a selected message. 

 Move to menu – Roll over the Move to menu to move the selected message to any of 
your existing folders, including your Inbox, Drafts, Sent Mail, Junk Mail, My Folders, 
or any subfolder within them. 

 More Actions menu – Roll over the More Actions menu to Print, Mark as Read, Flag a 
message for follow-up, Add to Address Book, Block Addresses, Open messages, or 
Select certain types of messages.   

 View menu – Roll over the View menu to select your Reading Pane style and message 
Sort By criteria. 

 Filter bar - Use the Filter tab to find emails from a specific person or by using 
keywords. Enter your search criteria or click the down arrow to enter advanced filter 
criteria. Click the Filter button to view the results. 
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Using My Email Beta 
My Email Inbox 
 
After logging into eChalk and clicking on the My Email button in the side toolbar, your email 
Inbox (Fig. 4.5) will display. The Inbox displays email messages that have been received. The first 
column in the email Inbox, a checkbox, enables you to select one or more messages in order to 
reply, forward, print, delete, move them to another folder, or take another action, simply by 
using the grey buttons that display at the top of the page.  
 

 
Fig. 4.5 

 
The red exclamation point in the second column displays when a message is of high 
importance, while a blue exclamation point displays when a message is of low priority. In the 
third column, the flag icon will display in red if that message has been flagged. The paper clip 
icon in the next column will display when a message includes an attachment. The column with 
an envelope distinguishes a read message from a new message. If the envelope is closed, the 
message has not been read. If the envelope is open, the message has been viewed. There are also 
icons in this column with arrows that indicate whether you have forwarded or replied to the 
message. Email messages that have not been read will also display in bold text.  
The remaining columns display who the message is from, the subject of the message, when it 
was received, and the size of the message. 
 
 
 

Power Tip: You can use the up and down 
arrows in the grey action toolbar or the up and 
down arrows on your keyboard to open emails 
in your reading pane. 

Power Tip: You can see how much storage 
space is used in each folder and subfolder 
and empty them to remain under quota. 
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The Space Used information at the bottom of your Inbox tells you how much email space you 
have used out of your total available email storage. If you click on the Space Used link, a 
window will open that displays the number of emails in each Folder and their total size. 
 
 
Using My Email Beta 
Reading Email 
 
Each time you open an email message, whether you are reading an existing email, composing a 
new email, replying to or forwarding an email, it will appear as a separate tab (Fig. 4.6) next to the 
tab of the folder you have opened.  
 

 
Fig. 4.6 

 
You can have up to 25 tabs open at one time. To scroll through your open tabs, you can use the 
left and right navigation arrows that display next to the last tab. To easily see a listing of all 
message headings, click the down arrow button to the right of the tabs. A list of the open tabs 
will display. Click on any one to view that tab or click on the corresponding X to close it.  
 

       To view an email message in your Inbox:  
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 

 
Note: To return to your Inbox from other screens or folders within 
My Email, click on the Inbox tab in the left navigation tree under My 
Email > Mailbox. 

 
2 Click on the bold text that displays in the Subject field of an unread email message to 

open it. Double-click on the message to open it in a tab or single-click on it to open the 
message in a reading pane (Fig. 4.7). 

 
Note: You can choose to read your email in one of two ways – 
opening the message, or reading the message in a reading pane that 
displays either below or to the right of the list of messages in your 
Inbox. To choose the desired message view option, roll over the 
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View menu at the top of the message listing. Next to the Reading 
Pane tab, click on Bottom, Right, or Off. 

 
3 If you’ve opened the message in a tab, you can close it by clicking the X next to the 

title of the tab. Or, you can leave it open and click back to your Inbox by clicking on 
Inbox in the left navigation tree or on the Inbox tab. 
 

 
Fig. 4.7 
 

 
Your email system provides you with an alternative to using the grey action toolbar at the top 
of your screen. While viewing email in the Inbox or in another Folder, you can right-click at 
any time on any message to choose from a menu of possible actions: 

 Delete – Click on the Delete button to delete this message. You will be asked to 
confirm the deletion. Click Yes to confirm or No to cancel.  

 Move to – Roll over the Move to menu to move this message to any of your existing 
folders, including your Inbox, Drafts, Sent Mail, Junk Mail, My Folders, or any 
subfolder within them. 

 Reply – Roll over the Reply menu to Reply to Sender or Reply All. 
 Forward – Click on this button to forward your message. 
 Open in tab – This action will open the message in a new tab. 
 More Actions – Roll over the More Actions menu to Print, Mark as Read, Flag it for 

follow-up, and Add to Address Book.   
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      To sort email messages in your Inbox:  

1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 In the grey action toolbar, roll over the View menu and scroll down to Sort By.  
3 In the Sort By options menu, select the specific criterion you want to search by. Your 

Inbox will automatically refresh according to the option you select:  
 Unread – Displays unread messages at the top of your inbox. 

 Sender – Sorts all messages by sender. 

 Subject – Sorts all messages alphabetically by subject. 

 Date – Sorts all messages chronologically by date. 

 Size – Sorts all messages by size. 

 Attachment – Displays messages that include attachments at the top of your inbox.  
 Flag – Displays all flagged messages at the top of your inbox. 

 
       To block email addresses:  

1 From your Inbox or another folder, check the box to the right of the message whose 
sender you would like to block from your email. Notice that you can check more than one 
email message at a time.  

2 Once you’ve selected the desired message, roll over the More Actions menu in the grey 
toolbar at the top of the screen and select the Block Addresses option.  

3 You will be asked to confirm that you want to block this address from your email. To do 
so, click Yes.  

 
Note: You may only block non-eChalk email messages. 

 
 
 
Using My Email Beta 
Writing Email 
Your email system provides you with a variety of ways to write emails. You can compose a new 
message by clicking on the Compose button under My Email in the left navigation area. A new 
message will open. Or, you can click on any of the response options (Reply, Reply All, 
Forward) from an email message you’ve received. 
 
If you are using one of the response options, your address and subject fields will already be 
filled in. Alternatively, you may use your Address Book or the Find Members tool rather than 
typing email addresses manually. For more information on these tools, please see “Searching 
Email” on page 20. If you type part of a name or email address, your eChalk email system will 
automatically complete the rest. Our new Autofill feature pulls email addresses saved in your 
Address Book to save you time. 
 
Notice that there are three different boxes in which to write email addresses: 

 To: is used to address the primary recipient(s). 
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 Cc: or carbon copy, is used when the email is not directly addressed to the person, but 
would still be of interest to him or her. Generally, you should use carbon copy if you don't 
expect or need a response from that person but would like the person to be aware of the 
contents of the email. 

 Bcc: or blind carbon copy, is used to include someone in an email without letting others 
know they are receiving it. 

 
Your eChalk Address Book automatically saves email addresses from incoming and outgoing 
email messages, making it easier for you to fill in your address area(s). You can even access 
your Address Book by clicking on the To, Cc or Bcc (Fig. 4.8) buttons. 
 

 
Fig. 4.8 

 
 
 

 To send a new email message: 
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Click the Compose button under My Email in the left navigation area. A new message 

tab will open. 
3 Click inside the To field and type the email address(es) of the person or people to 

whom you would like to send an email. You can also type part or all of the person's 
name. Your email system will automatically display matches according to the text you 
type if they are a member of the eChalk system or in your Address Book. Select the 
appropriate recipient to automatically complete the address in the To field. 

4 Alternatively, you can search for recipients’ names and addresses by clicking on the 
Find Members link to the right of the To field. For more help with this tool, please see 
“Finding Contacts” on page 24.  

 
Note: If you are entering multiple addresses, separate each new 
email address with a comma or semicolon. 
 

5 If desired, click inside the Cc box to add another person to your email. 
6 If desired, click the Show Bcc link and then click into the Bcc box to add another 

person to your email using a Bcc (blind carbon copy). Once you’ve chosen to show 
the Bcc field, the option to Hide Bcc will display instead of Show Bcc. If you click on 
this option, the system will ask you to confirm that you wish to delete any recipients 
you may have entered in the Bcc field.  

 

Power Tip: Use the Rich Text Editor option from the 
drop down menu to enhance the look and feel of your 
message text. You can use the hyperlink button to insert 
links to your Class Page, blog, and other web resources. 
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Note: As with the To field, your email system will automatically 
display matches according to the text you enter. Select the 
appropriate recipient to automatically complete the address in the Cc 
or Bcc field. 

 
7 Click in the Subject field of the email and type a brief subject. 
8 Using the Options button, you can set a priority for the message, request a return 

receipt, and/or automatically save the message to your Sent Mail folder. 

 To set a priority for the message you are composing, roll over the Options button 
and scroll down to Set Priority. Select High, Normal, or Low priority. By default, 
the priority of your message is Normal. 

 To request a return receipt when the recipient(s) reads this message, roll over the 
Options button and scroll down to Request return receipt. Select Yes or No. By 
default, you will not receive a return receipt.  

 By default, all messages will be automatically saved to the Sent Mail folder. To 
cancel this automatic save, roll over the Options button and scroll down to Save to 
Sent Mail. Select No. 
 

9 To attach one or more files to your email message, click the Browse button to the right 
of the Attach file(s) field and select the file(s) you wish to upload. For more 
information, see “Email Attachments” on page 11.  

10 Click into the body of the email and type your message. 
11 You can use the Rich Text Editor menu bar to format your message text without 

using HTML.  
12 To save a draft of your email message and come back to it later, you can click the 

Save button in the grey action bar at any point. A copy of the message will be saved in 
your Drafts folder, which you can access by clicking the Drafts tab in the left 
navigation tree under Mailbox. A draft of your message will be automatically saved 
every 60 seconds or every time you view another tab.  

13 Click the grey Spell Check button at the top of the screen to check for spelling errors 
in your message. For more information, see “Checking Spelling” on page 11.  

14 When you have finished composing your email, click the Send button. 
 
 

 To reply to an email message: 
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Select a message by single-clicking or double-clicking on the subject text from any 

folder listing. Your message with display in a Reading Pane or open as a new tab. 
3 Click the Reply button in the grey action toolbar at the top of the message to respond 

to the person who sent it to you. Click on the Reply All button to respond to everyone, 
including those included as a carbon copy (Cc). 

 
Note: You can also right-click on a message from your Inbox or 
another folder and roll over the Reply options to respond. 

 
4 Click inside the body of the email and type your message. The original message will 

display below your reply. 
5 Click the Send button to send the email. 
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 To forward an email message: 
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Select a message by single-clicking or double-clicking on the subject text from any 

folder listing. Your message with display in a Reading Pane or open in a new tab. 
3 From an open message, click the Forward button in the grey action bar. To forward a 

message while viewing it in a viewing pane, click on the Forward button in the grey 
action toolbar. Or, you can select the checkbox to the left of the message and click on 
the Forward button. Another alternative is to right-click on the desired email and select 
Forward from the list of options. 

4 Enter the desired email address or addresses in the To box. 
5 Click the Send button to forward the email. 
 
 

Using My Email Beta 
Email Attachments 
 
 

 To attach a file to an outgoing email message: 
1 Log in to eChalk and click My Email in the 

side toolbar. Your email Inbox will display. 
2 Click on the Compose button or select one of 

the Reply options to open a message. 
3 In your Compose screen, click the Browse 

button. The Upload File(s) (Fig. 4.9) pop-up 
window displays. 

4 Click the Browse button in the new window 
and select the desired file by navigating your 
computer’s directories to find the file.  

5 After you select your desired file, its name will 
display in the box to the left of the Browse button. To attach an additional file, click the 
Add button and repeat the selection process for the new file.  

6 After you’ve added all the files you wish to attach, click the Upload button to attach 
these files to your email. The attached files should display in the box to the left of the 
Browse button above the body of your message.  

 
 
Using My Email Beta 
Checking Spelling 
 
 

 To check your spelling: 
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Click on the Compose button or select one of the Reply options to open a message. 
3 At the top of your Compose screen, click the Spell Check button in the grey action 

toolbar. 

Fig. 4.9 
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Power Tip: If you know you’ll be using a word (maybe a 
proper name) often and don’t want the Spell Checker to 
catch it each time, click the Add tab at the bottom of the 
list of spelling choices to record this word in your spell 
checking dictionary. 
 

4 If there are no misspellings, the system will pop up the message: "No spelling errors 
were found." To return to your email message, simply click the OK button in the pop-
up window.  
If there are misspellings, the message will appear again, with all errors noted in red 
text (Fig. 4.10). Click on any red word to see a list of close matches and choose the 
desired word from this list. Alternatively, you can ignore the spelling correction, or 
correct the spelling yourself by typing the changes into the text box provided and 
clicking OK. Once you’ve fixed a word’s spelling, the corrected word will appear in 
green text.   
 In some cases, the Spell 

Checker may identify words 
that are correctly spelled, but 
not recognized by the Spell 
Checker. This often happens 
with proper names. Click the Ignore tab to accept your spelling. If there are 
multiple occurrences of a word that you want to accept click the Ignore All tab. 
 
Note: Each section of your email will be addressed separately, so 
even if you choose to Ignore All, your word will still display as 
suspect in the next section of your message. 
 
 

 
Fig. 4.10 
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5 The message "The spell check is complete" will appear when the spell check is 
finished. Click the OK button to return to your email. 

 
Note: Click the grey Stop Spell Check button at the top of the 
message body at any time during this process to save your changes 
and return to your email. 

 
 

 To view or change your spell check options: 
1 Log in to eChalk and click My Account in the side toolbar.  
2 Click the Profile button under My Account.  
3 Click the Edit Spell Check Options button in the top grey toolbar. The Edit Options 

screen (Fig. 4.11) will display. 
4 The available spell check options are:  

 Ignore capitalized words (e.g. Canada)  
 Ignore all-CAPS words (e.g. ASAP)    
 Ignore words with numbers (e.g. WIN98)   
 Ignore words with mixed case (e.g. SuperBase)   
 Ignore domain names (e.g. xyz.com) - Default   
 Ignore HTML markup (e.g. < b >) - Default    
 Report doubled words (e.g. the the) - Default   
 Case sensitive - Default   
 Suggest split words - Default   
 Phonetic suggestions   
 Typographical suggestions - Default   

 
5 You may also choose to add or remove words in your Spell Check dictionary or add or 

remove words to autocorrect. 
6 Once you've made your selections, click the Save button.  

 

 
Fig. 4.11 
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Note: If you navigate away from My Email (to My Account or My 
Classes), your open folder and message tabs will be saved. When 
you return to My Email, you can continue your work. 

 
 
Using My Email Beta 
Email Drafts 
 
As you work on new emails or new email replies, the eChalk email system automatically saves 
a draft of each. The drafts are stored in your Drafts folder, located in the left navigation tree 
under My Email. 
 

 
Fig. 4.12 

 
To retrieve your drafts, click on the Drafts tab in the left navigation tree under My Email > 
Mailbox. Your Drafts screen (Fig. 4.12) will display. Choose the message you wish to view. Once 
you send a message, the drafts are automatically deleted to avoid cluttering your Drafts folder. 
 
You can delete your drafts by selecting the checkboxes to the right of your messages, and then 
by clicking the Delete button located in the grey action toolbar at the top of the screen. Click 
Yes to permanently delete the draft or No to cancel the deletion. 
 
 
Using My Email Beta 
Deleting Emails 
 
 
There are several ways to delete email messages from your Inbox and Folders.  
 
You can delete individual messages by: 
 Clicking the Delete button (Fig. 4.13) in the grey action toolbar at the top of an open message. 
 Right-clicking on the desired email in your Inbox or another Folder and choosing Delete 

from the list of options that displays. 
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Fig. 4.13 

 
You can also delete several messages at once by: 
 Selecting the checkboxes to the right of the desired emails in your Inbox or another Folder. 
 Clicking the More Actions tab in the grey action toolbar, scrolling down to the Select tab 

and selecting from the list of options. 
 
Then, click on Yes to permanently delete the messages or No to cancel. 
   
To view messages you've deleted, click on the Deleted Mail tab in the side toolbar under My 
Email > Mailbox. Your Deleted Mail screen (Fig. 4.14) will display. In order to avoid exceeding 
your email storage limit, the messages in your Deleted Mail folder will be deleted permanently 
on a regular basis as indicated in your email Options. 
 

 
Fig. 4.14 

 
 
Using My Email Beta 
Printing Emails 
 
 
There are several ways to print emails. While viewing a message, click on the Print button in 
the grey action toolbar at the top of the message.  
 
Or, in your Inbox or another Folder, right-click on the desired email, scroll down to the More 
Actions tab and choose Print from the list of options that displays. You can also select the 
checkbox to the right of the desired email, click on the More Actions tab in the grey action 
toolbar, and click the Print button. 
 
The message will display in another window in an easy-to-read, professional format. In your 
browser’s File menu, choose the Print option. 
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Using My Email Beta 
Marking Emails as Read or Unread 
 
 
Emails you have not read yet will have bold subject headings in your inbox, while emails you 
have read will have normal lettering. An unread email message will also appear with a closed 
envelope image to the right of the From field; a read email will appear with an open envelope. 
When you first open an email message, it will automatically appear as a read message.  
 
To mark an email as read or unread directly from your inbox or any other folder, check the box 
to the right of the desired message(s). You can also choose to select all emails by clicking on the 
More Actions tab in the grey action toolbar, roll over Select and choose an option from the list 
that displays. 
 
In the More Actions tab, select either Mark as Read or Mark as Unread. Your Inbox or other 
folder will reload and the message(s) will appear with the subject heading in bold if they are 
marked as unread or in normal lettering if they are marked as read. 
 
 
Using My Email Beta 
Using Email Folders 
 
 
eChalk enables you to store and manage your email messages in folders to further organize 
your Inbox. Your eChalk Mailbox includes five standard email folders – Inbox, Drafts, Sent 
Mail, Deleted Mail, and Junk Mail, and your My Folders area includes any folders you have 
created. You can view each of these by clicking on them in your left navigation tree. Or, you can 
also view your folders by clicking the Folders button in the left navigation area under My 
Email. The Folders tab (Fig. 4.15) will then display. You can click on the folder names to view 
messages. 
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Fig. 4.15 

 
To rename a folder from the Folders tab, you can simply click on the folder name so that your 
desired folder is highlighted in grey. In the grey action toolbar at the top, choose the Rename 
option. Type the new folder name in the box provided, and press Enter or click out of the text 
box. You do not have the option to rename your Inbox, Drafts, Sent Mail, Deleted Mail and 
Junk Mail folders.  
 
 

 To create a new folder for your email: 
1 Log in to eChalk and click My Email in the side toolbar.  
2 Click the Folders button in the left navigation area under My Email. The Folders tab 

will display. 
 

Note: You can click this button at any time to access the Folders 
tab. 

 
3 Choose the folder in which you would like to create a subfolder and click the Create 

Subfolder button. You can create a subfolder in any of the folders except for the 
Inbox. Alternatively, you can right-click on the desired folder (except for the Inbox) 
located in the left navigation tree under My Email and choose the option to Create 
Subfolder.   
 

Note: It’s possible to create a new folder while moving a message 
from an existing folder. To do this, see the next set of instructions, 
“To move email messages into another folder”. 

 
4 Type a name for your new folder in the space provided and hit Enter. Your new folder 

will display in the folders tree in the side toolbar. 
 
 
 
 

Power Tip: If you’re a teacher, create 
folders for each of your classes under My 
Folders, and subfolders within each one for 
class sections, projects, and more. 
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Power Tip: You can move messages between folders by 
simply dragging the desired message(s) from an open 
folder into a folder in the left navigation tree. You can 
also drag and drop subfolders into other folders.  

 To move email messages into another folder: 
1 With an open message, roll over the More Actions button in the grey action bar at the 

top of the message and scroll down to the Move to button. Or, in your Inbox or 
another folder, check the box next to the email message(s) you would like to move.  
You can also select all emails by 
clicking on the More Actions tab 
in the grey action toolbar and 
choosing the Select All option 
from the list that displays. 

2 Select a folder or subfolder from 
the list that displays next to Move to. Scroll over the name of any folder to see a 
list of subfolders contained within it.  
 

Note: You may create a new subfolder within any folder during this 
process by clicking on the Add New Folder option. Type a name for 
the new folder and press Enter. The new folder will display in the 
folders tree. 

 
3 Click on the desired folder or subfolder to move your message into it. 

 
 

 To delete an email folder or subfolder: 
1 Log in to eChalk and click the My Email button in the side toolbar. 
2 Click the Folders button in the left navigation area under My Email. The Folders tab 

will display with a complete listing of your folders.  
 

Note: Click the plus sign to display all the subfolders inside any main 
folder. Click the minus sign to hide them. 

 
3 Click the name of the folder you wish to delete and select the Delete button.  
4 Click OK to confirm or Cancel to abandon the deletion. 

 
 
Alternatively, you can simply right-click on the My Folders root folder or any of the subfolders 
listed within it in the side toolbar under My Email > Mailbox. A drop down menu will display 
with options including Delete Folder (Fig. 4.16). Choose this option from the listing to delete the 
selected folder.  



                   Focus On… eChalk Email Beta 

 

Questions?  Contact support@echalk.com or 1-800-499-2741           

19 

 
Fig. 4.16 

 
 

 To empty an email folder or subfolder: 
1 Log in to eChalk and click the My Email button in the side toolbar. 
2 Click the Folders button in the side toolbar under My Email. The Folders tab will 

display with a complete listing of your folders.  
 

Note: Click the plus sign to display all the subfolders inside any main 
folder. Click the minus sign to hide them. 

 
3 Click the name of the folder you wish to empty and click the Empty button in the grey 

action toolbar at the top of the screen.  
4 Click OK to confirm or Cancel to abandon the process.  

 
 
Alternatively, you can simply right-click on the name of any of the folders in the left navigation 
tree under My Email > Mailbox. A drop down menu will display with options including Empty 
Folder. Choose this option from the listing to empty the selected folder. 
 
Depending on your security settings, email messages may be automatically moved to your 
Junk Mail folder, under My Email > Mailbox. A white list is a list of email addresses you do not 
want to be blocked by your SPAM filter settings. Please see “Security Settings” on page 28 for 
information on how to manage your white list. 
 
 

 To add email addresses to your white list: 
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on your Junk Mail folder in the left navigation tree under My Email > Mailbox. 

Your Junk Mail folder will display. 
3 Roll over the More Actions menu and select the White List Addresses option. The 

White List Addresses screen will display. 
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4 In the text box, enter the email addresses you would like included in your white list. 
5 Click Ok. Click on the X in the upper right-hand corner to exit the screen. 

 
 
Using My Email Beta 
Searching Email 
 
You may find that you need to refer back to information in an email, but you just can't 
remember which email you need. You can perform a keyword search that looks through all the 
email in a folder for a particular word or phrase.  
 
 

 To perform a simple search:  
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on the name of a folder or subfolder in the left navigation tree under My Email > 

Mailbox. 
 

Note: Click the plus sign next to a folder name to display all the 
subfolders inside. Click the minus sign to hide them. 

 
3 In the filter box (next to the magnifying glass icon) on the right side of the grey action 

bar, enter any keywords you wish to search for and click the Filter button to perform a 
simple search or simply press Enter. 
 

Note: The simple search function will look for keyword(s) only in the 
messages located in the folder you currently have opened, and only 
in the Subject and From fields. In the Sent Mail folder, the simple 
search function will look in the Subject, To, and Cc fields. 

 
4 A list of the email messages, if any, containing the keyword(s) and meeting the criteria 

you’ve entered will display. To return to your original view, click the Clear Filter 
Results button. 

 
 

 To perform an advanced search: 
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on the name of a folder or subfolder in the left navigation tree under My Email. 

 
Note: Click the plus sign next to a folder name to display all the 
subfolders inside. Click the minus sign to hide them. 

 
3 To perform an advanced search, click the down arrow to the right of the filter box (next 

to the magnifying glass icon) on the right side of the grey action bar. The Advanced 
Filter (Fig. 4.17) window will display. 
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Fig. 4.17 
 

4 If you remember the subject of the email or any keywords included in that subject, 
enter that information in the Subject field provided.  

5 Enter any keywords that might have appeared in the text of the email in the Body field.  
6 If you remember who sent the email to you, type his or her first and/or last name 

(partial names are acceptable) in the From box. 
7 If the email was sent to another recipient as well as to you, enter that person’s name in 

the To box in order to narrow your search.  
8 If you know roughly when the email message was sent or received, select a date 

range (the default is all emails) in the Sent Between fields using the small calendars 
provided. 

9 If you want to narrow your search further, select any or all of the options provided:  
 Flagged – Search for messages that are Flagged or Unflagged 
 Status – Search Read or Unread messages 
 Priority – Search for messages of High, Normal or Low priority 
 Attachment – Search for a message that Has attachments or Does not have 

attachments 
 Size – Search for a message by maximum and/or minimum size. 

 
10 Click the Find button to begin your search. A list will display including the email 

messages, if any, located within the folder you currently have open that contain the 
keyword(s) and meet the criteria you’ve entered. 
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Using Your Address Book 
 
 
Your Address Book (Fig. 4.18) is a great time saver. You can store email addresses or even 
groups of email addresses so that preparing an email message takes only a few mouse clicks. 
You won't have to memorize or retype someone's email address once you've saved it to your 
Address Book. 
 

 
Fig. 4.18 

 
 
Using Your Address Book 
Managing Contacts 
 
 

 To add a contact:  
1 Log in to eChalk and click My Email on the side toolbar.  
2 Click on Contacts in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Click the Add Contact button. The Add Contact page will display. 
4 Click in each field to fill in the form with information for the new contact. Certain fields, 

such as phone numbers, have drop down menus associated with them. As a shortcut, 
you need only fill in the email address and first or last name, but you may find it very 
useful to have all the contact's information stored in one place.  

5 Click the Save button when you're finished entering information for this contact. The 
Address Book will display. The new contact’s name and email address will appear on 
the Address Book page.  
 

Note: The Address Book is arranged alphabetically by contact 
name. To find a contact, click on the letter of that contact’s name 
(first of last name, depending on how you’ve entered it on the Add 
Contact page). 

 
Once you've added a contact to your Address Book, you may: 

 Click a name to edit the contact information, or  
 Click an email address to send an email to the contact. 



                   Focus On… eChalk Email Beta 

 

Questions?  Contact support@echalk.com or 1-800-499-2741           

23 

Power Tip: Add non-eChalk users to a group list 
by using the Add Contacts Manually feature 
and entering their email address.                             

 To add a group to your Address Book:  
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on Contacts in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Click the Add Group List button. The Add Group List page will display. 
4 Type a name for the group in the Group Name box, enter a description for the group 

and click Next. 
5 Select contacts to add to your group list by using any of the following options: 

 Click the Add Contacts Manually button if you want to manually type contacts 
into your Group List.  

 Click the Select Members button if you want to add contacts by conducting a 
search of your school or other sites within your district. 
Click the Add from Address 
Book button if you want to add 
contacts from your Address 
Book. 
 

6 Click the Finish button when you have finished entering the desired contact(s) to your 
group list. You will be returned to your Contacts page. 

 
 

 To edit a Group List:  
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on Contacts in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Click the Group List link to the right of the alphabet bar. The Group Lists page will 

display. 
4 Under the Group List column, click on the Group List name you would like to edit. The 

View Email Group List Settings page will display with the group’s profile information. 
5 Click on the Edit Members button. The Edit Email Contacts window will display. 
6 To remove a contact or contacts, select the checkbox next to the contact name. Or, 

check the Select All box if you wish to remove all members. 
7 To add more contacts to your group list, click on the Add Contacts Manually, Select 

Contacts, or Add from Address Book buttons. 
8 When finished, click Save. 

 
 

 To Import Contacts into your Address Book:  
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on Contacts in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Click the Import Contacts button. The Import Contacts page (Fig. 4.19) will display. 
4 In the Add Contacts text box, enter the name of your contact (First Name Last Name) 

followed by his or her email address (e.g. john.smith@echalk.com). Make sure each 
contact is listed on a separate line.  

5 When finished, click the Add to Address Book button, or click Cancel to cancel the 
import. You will be returned to the Address Book screen. 
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Note: Instead of entering your contacts manually, you can copy and 
paste them from a list.  

 
 

 
Fig. 4.19 

 
 

 To remove a contact from your Address Book:  
1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on the Contacts tab in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Check the box in front of the contact's name.  
 

Note: You can select more than one contact at a time, or you can 
select all your contacts by checking the box marked Select All.  

 
4 Click the Delete button. The contact(s) you’ve selected will be deleted from your 

Contacts list.  
 
 
Using Your Address Book 
Finding Contacts 
 
 
Your list of contacts is organized in alphabetical order. To find contacts, you can use the 
alphabet bar at the top of the page. Click the letter of your contact's last name for a filtered list. 
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If a contact name starts with a number instead of a letter, as in "5th Grade History Class," it will 
be listed before alphabetized contacts. Click the 123 link on the alphabet bar to view these 
contacts. Any names that display with asterisks (*) are private group distribution lists. Any 
names that display with tildes (~) are shared group distribution lists. 
 
A Contacts range bar also appears on the Address Book pages at the top right of the page. 
You may use it to browse through pages of contacts.  

 
 To email contacts using your Address Book:  

1 Log in to eChalk and click My Email on the side toolbar. 
2 Click on the Contacts tab in the left navigation tree under My Email > Mailbox. Your 

Address Book will display in a new window. 
3 Click the letter of the person's last name or group name on the alphabet bar. You can 

also click on the Group List link next to the alphabet bar to access a list of your 
groups. Once you've found the contact(s) you’re looking for, click the email address 
link. The Compose screen will display with the contact’s name filled in automatically in 
the To field.  
 

Note: Alternatively, you can select the checkbox to the left of the 
contact or Group List name and click the Send Mail button to open 
the Compose screen. 

 
4 Write your message. Click the Send button. 

 
In addition to using your Address Book to find contacts, you can utilize the Find Members 
tool (Fig. 4.20) to search through individuals within your eChalk community.  
 

 
Fig. 4.20 

 
 

 To email a contact using Find Members:  
1 Log in to eChalk and click My Email on the side toolbar.  
2 Click on the Compose button or select one of the Reply options to open a message. 
3 Click the Find Members link on the Compose screen. The Write Mail > Add 

Recipients from Find Members screen will display.  
4 If you would like to search within other sites in your district, click on Select sites to 

search. Select the checkbox(es) to the right of the sites in which you would like to 
search. Click Save. 
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Power Tip: Sometimes searching for a partial 
name will give better results because of the 
common differences in names. 

5 Or, you can search according to user type by selecting from All Users, 
Administration, Staff, Teachers, Students, Parents, Alumni, Site Administrators 
(Site Manager and Administrators only).  

6 Enter the member's Name in the Search 
Information area. If you don’t know the 
user’s full name, you can enter a partial 
name. 

7 To narrow your search, select other criteria by using the drop down lists that display for 
each user type. You can click on the Use Advanced Search link to search by Email 
Address, Position, and Creation Type. 

8 You can use Creation Type to search for parents that are registered to receive class 
email alerts. This search function is only available to Full Site Managers and Site 
Administrators with full Site Manager privileges. To narrow your search, choose one of 
three types: 
 eChalk Application – These users have been added manually using the eChalk 

application. 
 Implementation System – These users have been bulk-loaded at one time during 

the implementation process.  
 Self-Registered – This option only displays when the Parent user type is selected. 

These individual users have registered themselves to receive class email alerts 
and do not have pre-existing eChalk accounts. 

 
9 Click Find Now to begin the search. The Search Results page will display.  
10 The Search Results page will list some of the following information about the member 

including Last/First Name, Email address, User Type, User Status, Grade (PK-12), 
Position, and Year Graduated 

11 To sort your list, choose a column heading link at the top of the page to organize the 
list by Last Name, First Name, Email Address, User Type, User Status, Grade, 
Position or Year Graduated. To sort in ascending or descending order, click the 
arrow icon to the left of the heading column you're sorting.  

12 To select an individual on your search results list, check the box in front of his or her 
name. You may also select everyone on the list by checking the Select All checkbox 
at the bottom of the Search Results page. To deselect everyone, uncheck the Select 
All box.  

13 Click the OK button to add the selected user(s) as recipients of your email message. 
You will be returned to the Compose screen and the recipient(s) will now appear in 
the To field (or the Cc or Bcc field if you selected those options).  
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Setting Your Email Options 
 
 
 
Click My Email on the side toolbar, and then click on the Options tab in the left navigation tree 
to review and change the way you view, send, and store email in your account, add an 
electronic signature, and forward email to another address. The Options screen (Fig. 4.21) will 
display. 
 
On the Options screen (Fig. 4.21), you can click on the grey bars at the top of any section or the 
arrow at the right end of that bar to open or close that particular section.  
 

 
Fig. 4.21 

 
 
General Options  
 
At the top of the Options screen, there are four General Options (Fig. 4.21) that allow you to 
control your emails: 
 

 Refresh my Inbox – Determine how often you’d like your Inbox to automatically 
refresh. Choose a time interval from the drop down menu provided. 

 New email message alert - The system can sound an alert and pop up a new window 
to tell you when you have received a new message. Select the checkbox to enable this 
option. By default, a “You have mail” message will pop up at the bottom of your screen 
when new mail is received. 

 Automatic spell check – The Spell Check function can operate automatically when 
you send an email. Select the checkbox to enable this option. 

 Send a return receipt - A return receipt can be automatically sent to you when the 
recipient of one of your emails receives the email message. From the drop down menu 
provided, select one of the available options: Ask me, Always, or Never. 
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Fig. 4.22 

 
Security Settings  
 
In this section (Fig. 4.23), you can determine which mail should automatically be filtered out of 
your incoming messages and moved to your Junk Mail folder. You can choose from the 
following filter levels:  
 

 None – This is your default setting. No messages will be filtered. 
 High – This will filter out messages that are possibly junk mail. 
 Medium - This will filter out messages that are most likely junk mail. 
 Low - This will filter out messages that are obviously junk mail. 

 
Note: The higher your filter level, the more chances you’ll have of 
filtering valid messages by mistake. It’s important in any 
configuration to check your Junk Mail folder periodically. 

 

 
Fig. 4.23 

 
The Edit Blocked Addresses Filter and Edit White Listed Addresses Filter buttons (Fig. 4.23) 
will appear if you’ve blocked email addresses and/or added email addresses to your white list. 
Click on either of these buttons to edit the filter settings. Please see “To block email addresses” 
in the “My Email” section on page 8 and “To add email addresses to your white list” under 
“Using Email Folders” on page 16 for more information. 
 

Note: You can also edit these filters in the Advanced Options 
section of the Options screen. See “Advanced Options” in this 
section on page 32 for more information on filters. 

 
 
Storage Space 
 
In this section (Fig. 4.24), you can determine how you want messages to be stored in your Inbox 
and other folders. You can select the checkboxes next to the following options: 
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 Save deleted messages to the Deleted Mail folder 
 Save outgoing messages to the Sent Mail folder 
 Automatically archive messages – You can automatically archive messages that are 

older than a certain amount of time by selecting the appropriate checkbox. This will help 
your email folders load faster. Choose values from the drop down menus provided for 
the Deleted Mail, Sent Mail, Junk Mail, and Inbox folders. As messages are archived 
they will be placed in new folders. 

 Automatically delete messages – Alternatively, you can automatically delete old 
messages when you reach 98% of your email quota, so that your email system will run 
swiftly and efficiently. Select the second radio button and choose values from the drop 
down menus provided for the Deleted Mail, Sent Mail, Junk Mail, and Inbox folders.  

 

 
Fig. 4.24 

 
 
Message Signature  
 
Use the Message Signature section (Fig. 4.25) to automatically add an electronic signature to 
your emails. Signatures can include your contact information or a personal favorite quote. Select 
the checkbox next to Always include signature to automatically include this signature in your 
emails.  
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Fig. 4.25 

 
 
Forward/Reply  
 
These options (Fig. 4.26) allow you to receive email at another address and/or send an automatic 
reply message to anyone who sends you an email. This can be helpful during school holidays, 
vacations or for times when you may not be able to check your email. 
 

 
Fig. 4.26 

 

Power Tip: Select the Rich Text Editor in the 
drop down list at the top of the message 
signature text box to format your custom 
signature using fonts, styles, and colors. 
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 To forward your emails to another email address:  
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Click on the Options tab in the left navigation tree. Your Options screen will display. 
3 In the Forward/Reply section (Fig. 4.26) of the Options screen, type an alternate email 

address to which you want to forward all your incoming messages in the field provided. 
If you enter more than one email address, separate the individual addresses with 
commas. 

4 Click the Add button. The email address(es) you’ve entered will display in the list of 
Forwarding Addresses. 

5 If you want to delete the message from your eChalk Inbox after it has been forwarded 
to avoid cluttering your account, select the checkbox next to Don't leave a copy of 
the message in my email inbox.  

 
To disable message forwarding, in the Forward/Reply section of the Options screen, select each 
address in the list of Forwarding Addresses and click the Remove button.   
 
 

 To automatically reply to incoming email messages:  
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Click on the Options tab in the left navigation tree. Your Options screen will display. 
3 In the Forward/Reply section of the Options screen, select the checkbox labeled 

Reply to all incoming email with the following message. 
4 In the text box provided, type a message that you want the system to automatically 

send to everyone who sends you an email message. You may want to indicate that 
you’re away and when you expect to return. 

  
Note: When you return, remember to disable your Auto Reply 
messaging. 

 
5 You can auto-reply to each sender only once per day and/or include the original 

message in the auto-reply by selecting the appropriate checkbox(es). 
 
To disable the Auto Reply feature, simply return to the Options screen, open the 
Forward/Reply section, and uncheck the box labeled Reply to all incoming email with the 
following message. 
 
 
Wireless Settings for Emergency Alerts 
 
You can configure your mobile phone to receive emergency text message updates sent by your 
school’s Site Manager or other authorized person.  
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Fig. 4.27 

 
 

 To receive emergency alert text messages:  
1 In the Wireless Settings for Emergency Alerts section (Fig. 4.27) of the Options 

screen, choose your mobile phone carrier from the Mobile Carrier drop down menu. 
2 Enter your Mobile Phone Number, including the area code, in the field provided. 

Enter only the numbers with no dashes or other markings. 
3 The checkbox below will already be selected to automatically send a text message to 

your mobile device after you click the Save button to test your settings. 
 

Note: Standard text message rates will apply. 
 

4 Click the Save button at the bottom of the screen. 
 

If you do not receive the test message, please reconfigure your wireless settings, as there may be 
a problem with the carrier you’ve chosen or the cell number you’ve entered. 
 
 
Advanced Options 
 
In the Advanced Options section of the Options screen, you can create custom filters to 
automatically file your emails into folders according to criteria such as keywords, subject, etc. 
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Fig. 4.28 

 
 

 To create an email filter: 
1 Log in to eChalk and click My Email in the side toolbar. Your email Inbox will display. 
2 Click on the Options tab in the left navigation tree. Your Options screen will display. 
3 Open the Advanced Options section at the bottom of the Options screen, and then 

click the Filters link. The Filters window will display. 
4 Click the Add button at the top of the page or the Add an Email Filter link. The Add 

Filter page will display (Fig. 4.28). 
5 Enter a Filter Name. 
6 If desired, enter a description of the filter in the Filter Description box. 
7 Select the appropriate checkbox to determine your Filter Rules: 

 Filter messages where all of the following rules apply – Select this option if you 
wish to filter only messages that satisfy all the rules you configure 

 Filter messages where any of the following rules apply – Select this option if 
you wish to filter messages that satisfy any of those rules 

 
8 Create one or more filter rules using the drop down menus and text field provided. For 

example, if you want to block a specific sender from sending you email, select From in 
the first drop down menu, leave the second drop down menu with the selection 
contains selected, and then in the third text box type in the sender's email address. 

9 Check the Case Sensitive box if you want the rule to discriminate between lower case 
and upper case lettering.  
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10 You can enter more than one rule for any filter you create. To add the rule, click the 

Add Rule button at the bottom of the Filter Rules area. Once you have created more 
than one rule, you can choose to filter messages using any of the rules or all of the 
rules. To do this, check the appropriate box above the rules you’ve entered.  

11 In the Filter Action section, select where you'd like the filtered email to go: 
 Move to - Move the blocked mail to a specific email folder by choosing a folder 

name from the Select a Folder drop down menu. Selecting this option will 
automatically move the blocked email to the folder that you've selected.  

 Redirect to - Redirect the email to another email account (e.g. 
jane.smith@hotmail.com) by entering the email address in the box provided. 
Selecting this option will automatically forward the blocked email to the email 
address you've entered.   

 Discard message without notification to sender - Selecting this option will 
automatically delete the email without notifying the sender.  

 Discard message and notify sender that message has been rejected - 
Selecting this option will automatically delete the message and send a rejection 
email to the sender. 

 
12 When you have finished making your selections, click the Save button to return to the 

Filters window, where the new filter will display in the filters listing. 
13 Click Done to close the Filters window and return to the Options screen.  

 
 
To edit or delete an eChalk mail filter, click on the Filters link in the Advanced Options section 
of the Options screen. The Filters screen will display. To edit a filter, click on the filter name. 
After you make your edits, click the Save button. To delete an eChalk mail filter, check the box 
next to the filter you want to delete and click the Delete button. Click OK to confirm or Cancel 
to return to the Filters screen without making any changes. 
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Using My Email Beta 

Troubleshooting/FAQ 
Q: I accidentally deleted an important email and/or folder. Is there any way to retrieve it? 

A: The first step is to check your Deleted Mail folder for the message.  If the message is not in 
the Deleted Mail folder, then contact eChalk Support.  eChalk may restore specific emails 
received by users within the last 30 days. However, eChalk will not be able to restore emails 
that were deleted the same day they were received. 

Q: Why am I receiving unsolicited emails? How can I block these emails? 

A: While the eChalk system employs several methods to protect you from receiving the bulk of 
SPAM emails, you may still occasionally receive spam. You may create personal filters to block 
specific email addresses or emails containing certain keywords. To do this, refer to “Advanced 
Options” under Setting Your Email Options on page 32.  

Q: Can I share a personal group list with another user?  

A: Users do not have the option to share personal group lists with other users. If you wish to 
share an email list with members of a group, we recommend creating a Shared Email Group 
List. Only users with Site Administrator privileges have the ability to create shared email group 
lists. Once created, a Shared Email Group List will automatically display in the eChalk 
address books of all group members. Refer to your Site Manager guide for instructions. 

Q: How can I increase my email storage space? 

A: All users have a 100 megabyte default email storage limit which may be increased by the Site 
Manager for an additional fee. Email storage limits may be increased for all users of a particular 
user type (i.e. teachers, students, administrators, etc.) as well as for individual users. 

Q: A student/teacher received an offensive email. Can eChalk trace where this email message 
was sent from? 

A: Due to the sensitivity of incidents involving offensive or threatening emails sent to members 
of a school community, eChalk will only conduct an email investigation pursuant to the written 
request of a proper authority within the school or district. 

Q: Is there a limit to how many folders I can create? 

A: There is no file limit.  

Q: What’s the file size limit for sending attachments? 

A: The file size limit for sending attachments is 20 megabytes. 
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